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AN229767 
 

  

Intel Cyclone 10 GX FPGA を構成する QSPI フラ
ッシュの有効化  
  

About this document 

Scope and purpose 

AN229767は、Intel Quartus Prime Pro Generic Flash Programmerツールを使用して、アクティブシリアル 
(AS) モードで Intel Cyclone 10 GX FPGAを構成するために S25HS512T QSPIフラッシュを有効にする方法を
説明します。同じ方法は、それぞれのフラッシュデータシートに従ってフラッシュを構成することによ
り、他の QSPIフラッシュファミリを有効にする場合にも適用されます。 
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1 はじめに 
このドキュメントは、読者が Intel FPGAの開発に精通していることを前提に書かれています。 

Quartus Prime19.1以降のバージョンの Intelの Generic Flash Programmerツールは、サードパーティの
QSPIフラッシュを FPGA構成デバイスとして構成する方法を提供します。  

このアプリケーションノートでは、Generic Flash Programmerツールを使用して FPGA構成ビットストリ
ームファイルを S25HS512T QSPIフラッシュにロードする方法について説明します。その後、QSPIフラ
ッシュは、アクティブシリアル (AS) 構成を介して構成データをターゲット FPGAにロードします。 

このアプリケーションノートで紹介されている手順は、Quartus Prime Pro 19.2を使用して、クアッド
SPIインターフェースを備えた Semper™ Flashを搭載した Intel Cyclone 10 GX FPGA開発キット (特に
S25HS512T) で検証されました。この手順は、他のすべての Quartus Primeバージョン 19.1以降に適用さ
れる予定です。この手順は、それぞれのデータシートに従ってフラッシュと FPGAデバイスを構成する
ことにより、他の QSPIフラッシュファミリと Intel Arria 10 FPGAデバイスにも適用する必要がありま
す。 
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2 背景情報 
Intel Generic Flash Programmerは、Intel Stratix 10、Intel Arria 10、および Intel Cyclone 10 GX FPGAデバイ
スをサポートします。ただし、Intel Stratix 10デバイスの場合は、Secure Device Manager (SDM) ファーム
ウェアがフラッシュプログラミングフローを制御します。これらのフローは変更できません。したがっ
て、このアプリケーションノートで紹介されている手順は、Intel Stratix 10 FPGAデバイスには適用され
ません。 

次の図に、Generic Flash Programmer構成のデータフローを赤で示します。 
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3 手順 
Quartus Prime Programmerの Convert Programming Fileダイアログボックスから、Generic Flash 
Programmerの設定とコントロールにアクセスできます。 

Convert Programming Fileダイアログボックスを使用した Generic Flash Programmingには、次の高レベル
の手順が含まれます。 

1. *.sof FPGA構成ファイルを生成します。 
2. 新しい Configuration Deviceを定義します。 
3. *.sofファイルを*.jicファイルに変換します。このファイルは、構成データを格納するために QSPIフ
ラッシュをプログラムするために使用されます。 

4. Intel Quartus Prime Programmerを使用し、Intel FPGAダウンロードケーブルを接続して、*.jic構成デ
ータを QSPIフラッシュデバイスにプログラムします。 

3.1 *.sof FPGA構成ファイルを生成 
この手順は、このドキュメントではカバーされていません。*.sofファイルがすでに生成されていること
を前提としています。*.sofファイルの生成については、関連する Intelドキュメントを参照してくださ
い。 

3.2 新しい Configuration Deviceを定義 
新しい Configuration Deviceを定義する際、Quartus Primeソフトウェアは、設定のコレクションを、選
択した Device database directoryの場所にある*.xmlファイルに保存します。この構成は 1回だけ実行
する必要があります。新しい Configuration Deviceテンプレートは、Quartus Primeにリストされている
デフォルトの構成デバイステンプレートと同じように再利用できます。  

3.2.1 新しい構成デバイスを追加 
1. Quartus Prime Proソフトウェアを開き、File > Convert Programming Files…を選択してください。 
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2. Convert Programming File画面で以下を実行してください。 
 

 
a) プログラミングファイルタイプで*.jicファイルタイプを選択してください。 

Note: Modeオプションは、*.jicが選択されている場合にのみ選択できます。 

b) File nameフィールドで、変換された*.jicファイルを保存する場所を指定してください。  
c) 青い円のプルダウンメニューをクリックし、Active Serialを選択してください。 
d) 赤い丸をクリックしてください。 

3. << new device >>をクリックしてください。緑の円で構成可能なフィールドが表示されます。 
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4. 以下の変更を行ってください。 
 

 
• FPGAデバイスに応じて FPGAの Device familyと Configuration modeを設定してください。 
• *.xmlファイルが保存される Custom database directoryを指定してください。 
• QSPIフラッシュデバイスのデータシートに従って、フラッシュデバイスのパラメータを設定してく
ださい。 
− デバイス ID 
− デバイスの I/O電圧 
− デバイス密度 
− 総デバイスダイ 
− シングル I/Oモードダミークロック 
− クワッド I/Oモードダミークロック 

例えば、S25HS512Tデバイスの場合、S25HS512Tデータシートからこれらのパラメータを入力してく
ださい。 

5. Applyをクリックしてください。新しいデバイス”S25HS512T”が左側のリストに自動的に追加されま
す。 

Note:  

− フラッシュパラメータの設定では、Device nameとテンプレート名 (”Save as template”) を同じにす
ることはできません。それ以外の場合は、Applyボタンをクリックすると、”テンプレート名
xxxxxxがデバイス名 xxxxxxと競合します”というエラーメッセージが表示されます。 
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− Device IDは、0xAB 0xCD 0xEF形式の 3バイトの 16進データです。 

3.2.2 初期化フローテンプレートの変更 
 

 
1. 作成した Configuration Device (例として S25HS512T) を選択し、Initializationタブをクリックしてくだ
さい。 

Initializationタブには、フラッシュ初期化フローテンプレートが表示されます。テンプレートのアクシ
ョンを追加、削除、または変更できます。これは、デフォルトのフローテンプレートに基づく
S25HS512Tデバイスの変更を示します。必要に応じて、独自の初期化フローテンプレートを定義できま
す。 
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2. ウィンドウの左側で Read ID動作をクリックしてください。フラッシュデバイスのデータシートに従
って、右側 (緑色の円) のプロパティを構成します。 

3. 動作プロパティを設定したら、Applyをクリックしてください。 

デフォルトの”Write enable” 動作は、S25HS512Tの動作と同じです。この例では、このフィールドは変
更されていません。  
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4. 左側のウィンドウを下にスクロールして、Write registers動作をクリックしてください。プロパティ
を編集して、フラッシュレジスタを設定してください。  

この例では、S25HS512Tを 4バイトのアドレスモードに構成し、セクターアーキテクチャを均一な
256KBに設定してください。 

S25HS512T書き込みレジスタコマンドシーケンスは次のとおりです。書き込みレジスタコマンド 
(0x01) + STR1 (ステータスレジスタ-1) 値+ CFR1 (コンフィギュレーションレジスタ-1) 値+ CFR2 (コンフィ
ギュレーションレジスタ-2) 値+ CFR3 (コンフィギュレーションレジスタ-3) 値。 

STR1のデフォルト値は 0x00です。CFR1のデフォルトは 0x00です。 

CFR2のデフォルト値は 0x08です。4バイトアドレスモードの場合は、CFR2 [7]を’1’に設定してくださ
い。CFR2の新しい値は 0x88です。 

CFR3のデフォルト値は 0x00 (ハイブリッドセクターアーキテクチャ 4KB + 256KBセクター) です。均一
な 256KBセクターの場合は、CFR3 [3]を’1’に設定してください。CFR3の新しい値は 0x08です。 

したがって、0x01コマンドに続くデータは (右側の赤い円の上のスクリーンショットに示されている
ように) 0x00 0x00 0x88 0x08です。レジスタの詳細については、S25HS512Tのデータシートを参照して
ください。 



  

Application Note 10 of 28 002-32734 Rev. **  
  2021-03-10 

Intel Cyclone 10 GX FPGA を構成する QSPI フラッシュの有効化 
  
手順 

  

Note:  

− Intel Cyclone 10 GXおよび Arria10デバイスには、4バイトのアドレス指定フラッシュメモリが必要
です。フラッシュは 4バイトアドレス指定をサポートする必要があり、4バイトアドレスモードに
設定する必要があります。 

− デフォルトの消去フローテンプレートは、均一な 256KBセクターアーキテクチャ用です。消去フ
ローを単純化するためには、初期化フローでフラッシュを均一な 256KBセクターアーキテクチャ
として設定します。そうでない場合、消去フローはフラッシュアレイを完全に消去することはで
きません。これはエラーメッセージなしで発生する可能性があることに注意してください。 

 

 
5. Write register動作の後、書き込み操作のステータスを確認するために、ステータスレジスタを読み出
してください。 

STR1 [6]は P_ERR、STR1 [5]は E_ERR、STR1 [1]は WEL、STR1 [0]は RDYBSYです。プログラム操作が正
常に完了すると、これらの 4ビットはすべて 0になります。他のビットはドントケアです。したがっ
て、期待されるデータマスクは 0110 0011b (0x63) です。マスクされた期待データは 0x0です。ステー
タスレジスタビットの定義については、S25HS512Tデータシートを参照してください。 

この動作 (Read Status Register) は、フラッシュアレイプログラム/消去操作のステータスを確認する場
合と同じです。プログラムおよび消去フローテンプレートでも使用できます。 
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6. Set 4 byte addressing動作を右クリックし、Deleteをクリックしてから、Applyをクリックして変更
を保存してください。これは、このコマンドがフラッシュデバイスに適用できないためです。フラ
ッシュ (S25HS512T) の場合、前の書き込みレジスタ動作ですでに行われた 4バイトアドレス指定を設
定します。  
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3.2.3 プログラムフローテンプレートの変更 
1.  Programタブをクリックし、Page program動作をクリックしてください。 
 

 
2. フラッシュデータシートで指定されている最大ページプログラム時間に従って、Delayの値を変更し
てください。例えば、S25HS512Tの場合、最大ページプログラム時間は 2175 µsです。  

もう 1つのオプションは、遅延値を’0’に設定し、ステータスレジスタの読み出しアクションを追加し
て、次のようにページプログラム操作のステータスを確認することです。 

ページプログラムのサイズは、デフォルトのプログラムフローテンプレートと S25HS512T：256バイ
トで同じです。S25HS512Tは、512バイトのより大きなページプログラムサイズもサポートします。
CFR3x [4] = 1を設定することにより、この値を 512バイトに構成できます。S25HS512Tに 512バイト
のページプログラムサイズを使用するためには、初期化フローテンプレートの Write register動作で値
を設定してください。 



  

Application Note 13 of 28 002-32734 Rev. **  
  2021-03-10 

Intel Cyclone 10 GX FPGA を構成する QSPI フラッシュの有効化 
  
手順 

  

 

 
a) 矢印を右クリックし、Insert > Read Register を選択して、Read Register動作をフローに追加してく
ださい。 

 

 
b) 追加した動作をクリックして、そのプロパティを構成してください。 
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c) フラッシュデータシートに従ってプロパティを構成してください。これは、初期化テンプレート
に示される構成と同じです。 

時間 (Delay x Attempt count) は、フラッシュデータシートで指定されている最大ページプログラム時
間よりも大きくする必要があります。例えば、S25HS512Tの場合、最大ページプログラム時間は
2175 usです。したがって、Delay x Attempt count値は 2175 usより大きくなければなりません。
Read Registerアクションが期待されるマスクされたデータを返した後、フローは最大試行回数に達
することなく次のステップに進むため、より大きな値を入力できます。  

d) プロパティを構成したら、Applyをクリックしてください。 
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3.2.4 消去フローテンプレートの変更 
 

 

デフォルトの“Write enable”、および”Sector erase” 動作は、S25HS512Tの均一な 256KBセクター消去操
作と互換性があります。S25HS512Tは、初期化フローテンプレートのレジスタ Write register 動作で
256KBセクターアーキテクチャを統一するようにすでに構成されているため、これらの値は変更しない
でおけます。  
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1. Read status register動作をクリックし、Command、Expected data、data maskなどの S25HS512Tの
プロパティを更新してください。この動作は、初期化フローおよびプログラムフローの Read status 
register動作に似ています。 

Note: (Delay x Attempt count) は、フラッシュデータシートで指定されている最大 256KBセクター
消去時間よりも大きくする必要があります。S25HS512Tの場合、256KBEnduraFlex™アーキ
テクチャが有効になっていると 5869ミリ秒になります。詳細については、S25HS512Tの
データシートを参照してください。 

2. OKをクリックして変更を保存してください。 

これらの動作を構成した後、.sofファイルをフラッシュデバイスにロードできる.jicファイルに変換する
ように構成デバイスを設定してください。 
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3.3 .sofファイルを変換して.jicファイルを生成 
 

 
1. Programming file typeを JTAG Indirect Configuration File (.jic) に設定してください。 
2. Configuration deviceとして S25HS512T (前の手順で作成) を選択してください。 
3. Modeを Active Serialとして選択してください。 
4. 生成する.jicファイル名と生成した.jicファイルを保存する場所を指定してください。 
5. SOF Dataを選択し、Add File…をクリックしてください。 
6. 変換する.sofファイルを選択してください。 



  

Application Note 18 of 28 002-32734 Rev. **  
  2021-03-10 

Intel Cyclone 10 GX FPGA を構成する QSPI フラッシュの有効化 
  
手順 

  

 

 
7. .sofファイルを追加した後、Flash Loaderを選択し、Add Device…をクリックしてください。 
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8. 使用する FPGAデバイスに応じてデバイスを選択し、OKをクリックしてください。 
 

 

このアプリケーションノートでは、Cyclone10 GX 10CX220Y FPGAデバイスを搭載した Cyclone10 GX Dev
キットで手順を確認します。 

9. Generateをクリックしてください。 
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しばらくすると.jicファイルが正常に生成されたことを示すポップアップウィンドウが表示されま
す。 

 

 

これで、生成された.jicファイルを構成フラッシュ (この例では S25HS512T) にプログラムできます。 

3.4 .jic構成データを QSPIフラッシュデバイスにプログラム 
1. Intel FPGA JTAG USBダウンロードケーブルを介して Intel FPGAボードを PCに接続し、FPGAボードの
電源を入れてください。 

2. Quartus Prime Proから、Tools > Programmer を選択してください。 
3. Hardware Setup…をクリックしてください。 
 

 
4. USB-Blaster…をクリックしてください。  
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5. Auto Detectをクリックしてください。 
6. ポップアップウィンドウで 10M08SAを選択してください。これは、手順が検証された Cyclone10 GX
開発ボード上の MAX10 FPGAデバイスです。 
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7. ポップアップウィンドウで 10CX220Yを選択してください。これは、開発ボード上の Cyclone 10 GX 
FPGAデバイスです。  

 

 
8. Add File…をクリックしてください。 
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9. 前の手順で生成された.jicファイルを開いてください。 
 

 
10. .jicファイルを追加した後に追加のデバイスが表示された場合は、それを選択して Delateをクリック
してください。 
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11. Program/Configureオプションを有効にしてください (赤い円のチェックボックス。青い円のチェッ
クボックスも自動的に有効になります)。 

 

 
12. Startをクリックしてください。 
 

 
13. プログレスバーに 100% (Successful) と表示され、メッセージに”Successfully performs operations”と表
示されたら、ターゲットボードの電源を入れ直してください。 
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4 結論 
このアプリケーションノートでは、S25HS512T QSPI Semper Flashを有効にして Intel Cyclone 10 GX FPGA
デバイスを構成する方法について説明しました。 

このアプリケーションノートで紹介されている手順は、それぞれのデータシートに従ってフラッシュと
FPGAデバイスを構成することにより、他の QSPIフラッシュファミリと Intel Arria 10FPGAデバイスにも
適用されます。 
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5 参考資料 
• Intel Cyclone 10 GX FPGA開発キットユーザーガイド 

https://www.intel.com/content/www/us/en/programmable/documentation/hvu1509010715799.html?
wapkw=Intel%20Cyclone%2010%20GX%20FPGA%20Development%20Kit%20User%20Guide 

• Generic Flash Programmerユーザーガイド：Intel Quartus Prime Pro Edition 

https://www.intel.com/content/www/us/en/programmable/documentation/pah1554479151020.html?
wapkw=Generic%20Flash%20Programmer 

• S25HS-Tデータシート 

 

  

https://www.intel.com/content/www/us/en/programmable/documentation/hvu1509010715799.html?wapkw=Intel%20Cyclone%2010%20GX%20FPGA%20Development%20Kit%20User%20Guide
https://www.intel.com/content/www/us/en/programmable/documentation/hvu1509010715799.html?wapkw=Intel%20Cyclone%2010%20GX%20FPGA%20Development%20Kit%20User%20Guide
https://www.intel.com/content/www/us/en/programmable/documentation/pah1554479151020.html?wapkw=Generic%20Flash%20Programmer
https://www.intel.com/content/www/us/en/programmable/documentation/pah1554479151020.html?wapkw=Generic%20Flash%20Programmer
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重要事項 
本文書に記載された情報は、いかなる場合も、
条件または特性の保証とみなされるものではあ
りません（「品質の保証」）。本文に記された
一切の事例、手引き、もしくは一般的価値、お
よび／または本製品の用途に関する一切の情報
に関し、インフィニオンテクノロジーズ（以
下、「インフィニオン」）はここに、第三者の
知的所有権の不侵害の保証を含むがこれに限ら
ず、あらゆる種類の一切の保証および責任を否
定いたします。 
 
さらに、本文書に記載された一切の情報は、お
客様の用途におけるお客様の製品およびインフ
ィニオン製品の一切の使用に関し、本文書に記
載された義務ならびに一切の関連する法的要
件、規範、および基準をお客様が遵守すること
を条件としています。 
 
本文書に含まれるデータは、技術的訓練を受け
た従業員のみを対象としています。本製品の対
象用途への適合性、およびこれら用途に関連し
て本文書に記載された製品情報の完全性につい
ての評価は、お客様の技術部門の責任にて実施
してください。 

 
本製品、技術、納品条件、および価格について
の詳しい情報は、インフィニオンの最寄りの営
業 所 ま で お 問 い 合 わ せ く だ さ い
（www.infineon.com）。 
 

警告事項 
技術的要件に伴い、製品には危険物質が含まれ
る可能性があります。当該種別の詳細について
は、インフィニオンの最寄りの営業所までお問
い合わせください。 
 
インフィニオンの正式代表者が署名した書面を
通じ、インフィニオンによる明示の承認が存在
する場合を除き、インフィニオンの製品は、当
該製品の障害またはその使用に関する一切の結
果が、合理的に人的傷害を招く恐れのある一切
の用途に使用することはできないこと予めご了
承ください 
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